Preface
Copyright

This publication, including all photographs, illustrations and software, is protected
under international copyright laws, with all rights reserved. Neither this manual, nor
any of the material contained herein, may be reproduced without written consent of
the author.

Version 1.0C

Disclaimer

The information in this document is subject to change without notice. The manufac-
turer makes no representations or warranties with respect to the contents hereof and
specifically disclaims any implied warranties of merchantability or fitness for any
particular purpose. The manufacturer reserves the right to revise this publication and
to make changes from time to time in the content hereof without obligation of the
manufacturer to notify any person of such revision or changes.

Trademark Recognition

Microsoft, MS-DOS and Windows are registered trademarks of Microsoft Corp.

MMX, Pentium, Pentium-II, Pentium-III, Celeron are registered trademarks of Intel
Corporation.

Other product names used in this manual are the properties of their respective
owners and are acknowledged.

Federal Communications Commission (FCC)

This equipment has been tested and found to comply with the limits for a Class B
digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to
provide reasonable protection against harmful interference in a residential installa-
tion. This equipment generates, uses, and can radiate radio frequency energy and, if
not installed and used in accordance with the instructions, may cause harmful inter-
ference to radio communications. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one
or more of the following measures:

. Reorient or relocate the receiving antenna

. Increase the separation between the equipment and the receiver

. Connect the equipment onto an outlet on a circuit different from that to
which the receiver is connected

. Consult the dealer or an experienced radio/TV technician for help

Shielded interconnect cables and a shielded AC power cable must be employed with
this equipment to ensure compliance with the pertinent RF emission limits governing
this device. Changes or modifications not expressly approved by the system’s manu-
facturer could void the user’s authority to operate the equipment.
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Declaration of Conformity

This device complies with part 15 of the FCC rules. Operation is subject to the

following conditions:

. This device may not cause harmful interference.

. This device must accept any interference received, including interfer-
ence that may cause undesired operation.

Canadian Department of Communications

This class B digital apparatus meets all requirements of the Canadian Interference-

causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Réglement sur

le matériel brouilieur du Canada.

The manual consists of the following:
Chapter 1
Introducing the Motherboard

Chapter 2
Installing the Motherboard

Chapter 3
Using BIOS

Chapter 4
Using the Motherboard Software

Chapter 5
Trouble Shooting
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Chapter1
Introducing the Motherhoard

Introduction

Thank you for choosing the H61H2-M3 motherboard. This motherboard is a high
performance, enhanced function motherboard designed to support the LGA1155
socket for latest Intel® Core™ Family/ Pentium®/ Celeron® processors*'.

This motherboard is based on Intel® H61 Chipset for best desktop platform solution.
Hol is a single-chip, highly integrated, high performance Hyper-Threading periph-
eral controller, unmatched by any other single chip-device controller. This
motherboard supports up to 8 GB of system memory with dual channel DDR3 1333/
1066 SDRAM. Two PCI are supported, fully compliant with PCI rev 2.2 specifica-
tion at 33MHz. High resolution graphics via PCI Express x16 slot, intended for
Graphics Interface, is fully compliant to the PCI Express Base Specification revision
2.0. In addition, one PCI Express slot is supported. It implements an EHCI (En-
hanced Host Controller Interface) compliant interface that provides ten USB 2.0
ports (six USB 2.0 ports at the back panel and two USB 2.0 headers support addi-
tional four USB 2.0 ports). The gray USB 2.0 header provides EZ charger technol-
ogy, please reference chapter 2 parts of Front Panel USB headers to check the detail
information. H61H2-M3 implements optional USB 3.0 chip which provides two
optional USB 3.0 ports*? at rear [/O with blue connectors also.

The motherboard is equipped with advanced full set of I/O ports in the rear panel,
including PS/2 mouse and PS/2 keyboard connectors, one DVI (co-lay HDMI) port,
one D sub (VGA) port, one Lan port, six USB 2.0 ports, which includes two USB
ports with optional USB 3.0 specification running at 5 Gb/s, and audio jacks for
microphone, line-in and line-out.

In addition, this motherboard supports four SATA 3Gb/s connectors for expansion.

slot can run at Gen3 speed, which accelerates on 32GB/s rate that effectively
delivers double of PCI Express Gen2 speed.

*2-1 The USB 3.0 connectors are optimized for SuperSpeed USB 3.0
devices, aslo are fully backwards-compatible with Hi-Speed USB 2.0 de-

vices.

g ; *] When accommodating Intel 3.« Generation CPU, the PCI Express 16X

*2-2 The USB 3.0 connectors are optional, please refer to the detail informa-
tion in page 22 and take the object as the standard.
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Feature
Processor

The motherboard uses an LGA1155 type of socket that carries the following

features:

. Accommodates the LGA1155 socket for latest Intel® Core™ Family/
Pentium®/ Celeron® processors.

. Supports “Hyper-Threading” technology CPU

. One PCI Express x16 Gen2 port supporting up to 5 GB/s direction peak
bandwidth

“Hyper-Threading” technology enables the operating system into thinking

it’s hooked up to two processors, allowing two threads to be run in parallel, both

on separate “logical” processors within the same physical processor.

Chipset

The Intel H61 Chipset is a single-chip with proven reliability and performance.
. Support one PCIl Express slot

. Integrated four SATA 3.0 Gb/s Host Controller

. Ten USB 2.0 ports supported

. Serial Peripheral Interface (SPI) support

. Integrated Graphics Support with PAVP 1.5

. Intel® High Definition Audio Controller

Extra Chips
. ITE 1T8893 PCI Bridge supports two PCI slots expansion

Memory

. Supports DDR3 1333/1066 DDR3 SDRAM with Dual-channel architec-
ture

. Accommodates two unbuffered DIMMs

. Up to 4 GB per DIMM with maximum memory size up to 8 GB

Audio

. 5.1+2 Channel High Definition Audio Codec

. Meets Microsoft WLP3.x (Windows Logo Program) audio
requirements

. All DACs supports 44.1k/48k/96k/192kHz sample rate

. Software selectable 2.5V/3.2V/4.0V VREFOUT

. Direct Sound 3D. compatible

. Power Support: Digital: 3.3V; Analog: 5.0V

Introducing the Motherhoard



Onboard LAN (Optional)

The onboard LAN provides the following features:

Supports PCI Express™ 1.1
Integrated 10/100/1000 transceiver
Wake-on-LAN and remote wake-up support

Supports PCI Express ™ 1.1
Integrated 10/100 transceiver
Wake-on-LAN and remote wake-up support

Expansion Options

The motherboard comes with the following expansion options:

One PCI Express x16 slot for Graphic Interface
One PCI Express slot

Two 32-bit PCI v2.2 compliant slots

Four SATA connectors

Integrated I/0O

The motherboard has a full set of I/O ports and connectors:

&

One LAN port

One D-sub (VGA) port

One DVI port ( HDMI Port optional)

Six USB 2.0 ports (including two USB ports with optional USB 3.0*
specification running at 5 Gb/s.)

One PS/2 keyboard and PS/2 mouse connectors

Audio jacks for microphone, line-in and 6-ch line-out

*The USB 3.0 connectors are optional, please refer to the detail informa-
tion in page 22 and take the object as the standard.

BIOS Firmware

This motherboard uses AMI BIOS that enables users to configure many system
features including the following:

Power management
Wake-up alarms

CPU parameters

CPU and memory timing
Graphic parameters

The firmware can also be used to set parameters for different processor clock
speeds.

&

1. Some hardware specifications and software items are subject to change
without prior notice.

2. Due to chipset limitation, we recommend that motherboard be operated
in the ambiance between 0 and 50 ° C.
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Specifications

CPU . LGA1155 socket for latest Intel® Core™ Family/ Pentium®/
Celeron® processors
. Supports “Hyper-Threading” technology CPU

Chipset . Intel® H61 Chipset
Extra Chips - ITE 1T8893 PCI Bridge supports two PCI slots expansion

Memory . Dual-channel DDR3 memory architecture
. 2 x 240-pin DDR3 DIMM sockets support up to 8 GB
. Supports 1333/1066 DDR3 SDRAM

Expansion . 1 x PCI Express x16 Gen2 slot
Slots . 1 x PCI Express slot

. 2 x PCl slots
Storage . Supported by Intel® H61 Express Chipset

-4 x Serial ATA 3.0 Gb/s Host Controllers

Audio . Realtek ALC662 6-Ch HD audio CODEC

. Compliant with HD audio specification
LAN . Realteck RTL8105E Lan (Co-lay RTL 8111E Gigabit Lan )

Rear Panel I/O - 6 x USB 2.0 ports (including 2 x USB ports with optional USB
3.0 specification running at 5 Gb/s)
. 1 x DVI port (HDMI port optional)
. 1 x VGA port
. 1 x RJ45 LAN connector
. 1 x PS/2 keyboard & PS/2 mouse connectors
. 1 x Audio port (Line in, microphone in, 6-ch line out)

Internal I/0 . 1 x 24-pin ATX Power Supply connector
Connectors & * 1 x 4-pin ATX Power Supply connector
Headers . 1 x 4-pin CPU_FAN connector

. 1 x 3-pin SYS_FAN connector

. 4 x Serial SATA 3.0 Gb/s connectors

. 1 x Front panel switch/LED header

. 1 x Front panel audio header

. 2 x USB 2.0 headers support additional four USB 2.0 ports

(F_USB1 supports EZ charger)

. 1 x Case Open header

. 1 x COM header

. 1 x SPDIF out header

. 1 x SPK header

. 1 x Clear CMOS header
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System BIOS

AMI BIOS with 32Mb SPI Flash ROM

Supports Plug and Play, S1/ STR (S3) / STD (S4) , Hard-
ware monitor

Supports ACPI & DMI

F7 hot key for boot up devices option

Supports PgUP clear COMS Hotkey

Supports eBLU* / eDLU / eSF* (* Warning: Microsoft .NET
Framework 3.5 is required)

Supports Graphic Over-Clocking

Supports Multi-Monitor technology

Supports Intel Turbo Boost Monitor Utility

Form Factor

" Micro ATX Size, 244mm x 200mm
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Motherboard Components
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Table of Motherboard Components

LABEL COMPONENTS

1 CPU Socket LGAllSj socket f;)r Latest Intel” Core™ Family/
Pentium /Celeron Processors

2. CPU_FAN 4-pin CPU cooling fan connector

3.DDR3_1~2 240-pin DDR3 SDRAM slots

4, ATX_POWER Standard 24-pin ATX power connector

5. SATA1~2 Serial ATA 3.0 Gb/s connectors

6. SATA3~4 Serial ATA 3.0 Gb/s connectors

7.F_PANEL Front panel switch/LED header

8. CASE CASE open header

9. ME_UNLOCK ME unlock header-for factory use only

10. F_USB1 Front panel USB header (it supports EZ Charger)

11. F_USB2 Front panel USB header

12. CLR_CMOS Clear CMOS jumper

13. SPK Speaker header

14. COM Onboard serial port header

15. SYS_FAN 3-pin system cooling fan connector

16. SPDIFO SPDIF out header

17. F_AUDIO Front panel audio header

18. PCI 32-bit add-on card slots

19. PCIE1 PCI Express x1 slot

20. PCIEX16 PCI Express slot for graphics interface

21. ATX12V 4-pin +12V power connector

This concludes Chapter 1. The next chapter explains how to install the motherboard.
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Chapter 2
Installing the Motherhoard

Safety Precautions

. Follow these safety precautions when installing the motherboard

. Wear a grounding strap attached to a grounded device to avoid dam-
age from static electricity

. Discharge static electricity by touching the metal case of a safely
grounded object before working on the motherboard

. Leave components in the static-proof bags they came in

. Hold all circuit boards by the edges. Do not bend circuit boards

Choosing a Computer Case

There are many types of computer cases on the market. The motherboard complies
with the specifications for the micro ATX system case. Some features on the
motherboard are implemented by cabling connectors on the motherboard to indica-
tors and switches on the system case. Make sure that your case supports all the
features required.

Most cases have a choice of I/O templates in the rear panel. Make sure that the I/O
template in the case matches the I/O ports installed on the rear edge of the
motherboard.

This motherboard carries a micro ATX form factor of 244 x 200 mm. Choose a case
that accommodates this form factor.

Installing the Motherboard in a Case

Refer to the following illustration and instructions for installing the motherboard in
a case.

Most system cases have mounting brackets installed in the case, which correspond
the holes in the motherboard. Place the motherboard over the mounting brackets
and secure the motherboard onto the mounting brackets with screws.

Ensure that your case has an I/O template that supports the I/O ports and expansion
slots on your motherboard.

Installing the Motherhoard
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% Do not over-tighten the screws as this can stress the motherboard.

Checking Jumper Settings

This section explains how to set jumpers for correct configuration of the motherboard.
Setting Jumpers

Use the motherboard jumpers to set system configuration options. Jumpers with
more than one pin are numbered. When setting the jumpers, ensure that the jumper
caps are placed on the correct pins.

The illustrations show a 2-pin jumper. When

the jumper cap is placed on both pins, the W
jumper is SHORT. If you remove the jumper
cap, or place the jumper cap on just one pin,

the jumper is OPEN. SHORT OPEN
This illustration shows a 3-pin jumper. Pins
1 and 2 are SHORT. @

s



Checking Jumper Settings
The following illustration shows the location of the motherboard jumpers. Pin 1 is
labeled.

CLR_CMOS

Jumper Settings

Jumper Type | Description Setting (default)
1-2: NORMAL

2-3: CLEAR 1

CLR_CMOS)| 3-pin | Clear CMOS Before clearing the |CLR_CMOS
CMOS, make sure to

turn off the system.

To avoid the system instability after clearing CMOS, we recommend
users to enter the main BIOS setting page to “Load Default Settings”
and then “Save and Exit Setup”.

Installing the Motherhoard
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Installing Hardware
Installing the Processor

Caution: When installing a CPU heatsink and cooling fan make sure that
you DO NOT scratch the motherboard or any of the surface-mount resis-
tors with the clip of the cooling fan. If the clip of the cooling fan scrapes
across the motherboard, you may cause serious damage to the motherboard
or its components.

On most motherboards, there are small surface-mount resistors near the
processor socket, which may be damaged if the cooling fan is carelessly
installed.

Avoid using cooling fans with sharp edges on the fan casing and the clips.
Also, install the cooling fan in a well-lit work area so that you can clearly
see the motherboard and processor socket.

Before installing the Processor

This motherboard automatically determines the CPU clock frequency and system bus
frequency for the processor. You may be able to change the settings in the system
Setup Utility. We strongly recommend that you do not over-clock processors or
other components to run faster than their rated speed.

/ /) Warning:
1. Over-clocking components can adversely affect the reliability of the
system and introduce errors into your system. Over-clocking can perma-
nently damage the motherboard by generating excess heat in components
that are run beyond the rated limits.

2. Always remove the AC power by unplugging the power cord from the
power outlet before installing or removing the motherboard or other
hardware components.

This motherboard has an LGA1155 socket. When choosing a processor, consider the
performance requirements of the system. Performance is based on the processor
design, the clock speed and system bus frequency of the processor, and the quantity
of internal cache memory and external cache memory.

Fail-Safe Procedures for Over-clocking

When end-users encounter failure after attempting over-clocking, please take the
following steps to recover from it.

1. Shut down the computer.

2. Press and hold the “Page Up Key (PgUp)” of the keyboard, and then boot the PC
up.

3. Two seconds after the PC boots up, release the “Page Up Key (PgUp)”.

4. The BIOS returns to the default setting by itself.

Installing the Motherhoard



CPU Installation Procedure

The following illustration shows CPU installation components.

A. Opening of the Load Plate
Put your thumb on the tail of the load
plate and press the tail down.
Rotate the load plate to fully open
position.

B. Disengaging of the Load Lever
- Hold the hook of lever and pull it to the
left side to clear retention tab.
Rotate the load lever to fully open
position.

C. Removing the Cap
- Be careful not to touch the contact at
any time.

D. Inserting the Package

- Grasp the package. Ensure to grasp on
the edge of the substrate.

Make sure pin 1 indicator is on your
bottom-left side.
- Aim at the socket and place the package
carefully into the socket by purely
vertical motion.

E. Closing the Load Plate
- Rotate the load plate onto the package
IHS (Intergraded Heat Spreader).
Engage the load lever while pressing
down lightly onto the load plate.
Secure the load lever with the hook
under retention tab.

F. Fasten the cooling fan supporting base
onto the CPU socket on the motherboard.

G. Make sure the CPU fan is plugged to the
CPU fan connector. Please refer to the
CPU cooling fan user’'s manual for more
detail installation procedure.

Installing the Motherhoard



14

1. To achieve better airflow rates and heat dissipation, we suggest
@ that you use a high quality fan with 3800 rpm at least. CPU fan and

heatsink installation procedures may vary with the type of CPU fan/

heatsink supplied. The form and size of fan/heatsink may also vary.

2. DO NOT remove the CPU cap from the socket before installing a
CPU.

3. Return Material Authorization (RMA) requests will be accepted
only if the motherboard comes with the cap on the LGA1155 socket.

Installing Memory Modules

This motherboard accommodates two memory modules. It can support two 240-pin
DDR3 1333/1066. The total memory capacity is 8 GB.

DDR3 SDRAM memory module table

Memory module Memory Bus

DDR3 1066 533 MHz
DDR3 1333 667 MHz

You must install at least one module in any of the two slots. Total memory capacity
is 8 GB.

Do not remove any memory module from its antistatic packaging until
you are ready to install it on the motherboard. Handle the modules only
by their edges. Do not touch the components or metal parts. Always wear
a grounding strap when you handle the modules.

Installing the Motherhoard



Installation Procedure

Refer to the following to install the memory modules.

1

3

This motherboard supports unbuffered DDR3 SDRAM .

Push the latches on each side of the DIMM slot down.

Align the memory module with the slot. The DIMM slots are keyed with
notches and the DIMMs are keyed with cutouts so that they can only be
installed correctly.

Check that the cutouts on the DIMM module edge connector match the
notches in the DIMM slot.

Install the DIMM module into the slot and press it firmly down until it
seats correctly. The slot latches are levered upwards and latch on to
the edges of the DIMM.

Install any remaining DIMM modules.

* For reference only

Installing the Motherhoard
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Expansion Slots

Installing Add-on Cards

The slots on this motherboard are designed to hold expansion cards and connect them
to the system bus. Expansion slots are a means of adding or enhancing the
motherboard’s features and capabilities. With these efficient facilities, you can in-
crease the motherboard’s capabilities by adding hardware that performs tasks that are
not part of the basic system.

PCIEX16 Slot

PCIE1 Slot

PCI1~2 Slots

PCIEX16 Slot

PCIE1 Slot

PCI1~2 Slots

&

alalk

s
5

The PCI Express x16 slot is used to install an external PCI
Express graphics card that is fully compliant to the PCI Express
Base Specification revision 2.0.

The PCI Express x1 slot is fully compliant to the PCI Express
Base Specification revision 2.0.

This motherboard is equipped with two standard PCI slots. PCI
stands for Peripheral Component Interconnect and is a bus stan-
dard for expansion cards, which for the most part, is a supple-
ment of the older ISA bus standard. The PCI slots on this board
are PCI v2.2 compliant.

Before installing an add-on card, check the documentation for
the card carefully. If the card is not Plug and Play, you may
have to manually configure the card before installation.



Follow these instructions to install an add-on card:

1 Remove a blanking plate from the system case corresponding to the
slot you are going to use.

2 Install the edge connector of the add-on card into the expansion slot.
Ensure that the edge connector is correctly seated in the slot.

3

Secure the metal bracket of the card to the system case with a screw.

_-_ps EAXTESES

| o

al Giga

&

et A B
Audio Du

* For reference only

1. For some add-on cards, for example graphics adapters and network
adapters, you have to install drivers and software before you can begin using
the add-on card.

2. The onboard PCI interface does not support 64-bit SCSI cards.

Installing the Motherhoard
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Connecting Optional Devices

Refer to the following for information on connecting the motherboard’s optional
devices:

F_AUDIO: Front Panel Audio header

This header allows the user to install auxiliary front-oriented microphone and line-
out ports for easier access.

Pin Signal Name Pin Signal Name
1 PORT 1L 2 AUD_GND
3 PORT 1R 4 PRESENCE#
5 PORT 2R 6 SENSE1_RETURN
7 SENSE_SEND 8 KEY
9 PORT 2L 10 SENSE2 RETURN

SATA1/2: Serial ATA connectors

These connectors are used to support the Serial ATA 3.0Gb/s device, simpler disk
drive cabling and easier PC assembly.

Pin Signal Name Pin Signal Name
1 Ground 2 TX+
3 TX- 4 Ground
5 RX- 6 RX+
7 Ground - -

Installing the Motherhoard



SATA3~4: Serial ATA connectors
These connectors are used to support the Serial ATA 3.0Gb/s devices, simpler disk
drive cabling and easier PC assembly. It eliminates limitations of the current Parallel

ATA interface. But maintians register compatibility and sofeware compatibility with
Prallel ATA.

Pin Signal Name Pin Signal Name
1 Ground 2 TX+
3 TX- 4 Ground
5 RX- 6 RX+
7 Ground - -

F_USB1~2: Front Panel USB headers

The motherboard has two USB 2.0 headers supporting four USB 2.0 ports. Addition-
ally, some computer cases have USB ports at the front of the case. If you have this
kind of case, use auxiliary USB connector to connect the front-mounted ports to the
motherboard.

Unlike F_USB2 in this mainboard, F_USBI1 supports EZ Charger technology, pro-
vides 3 times current than general USB port in off mode for USB devices. It is useful
and excellent, especially for the iPhone, iPad and iPod touch devices that need a
large amount of current for faster recharging within less time.

Pin Signal Name Function
1 USBPWR Front Panel USB Power
2 USBPWR Front Panel USB Power
3 USB_FP_PO- USB Port 0 Negative Signal
4 USB_FP_P1- USB Port 1 Negative Signal
5 USB_FP_P0+ USB Port 0 Positive Signal
6 USB_FP_P1+ USB Port 1 Positive Signal
7 GND Ground
8 GND Ground
9 Key No pin

10 NC Not connected

indicated above. A different pin assignment may cause damage or system

( Z Please make sure that the USB cable has the same pin assignment as
hang-up.

Installing the Motherhoard
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SPDIFO: SPDIF out header
This is an optional header that provides an SPDIFO (Sony/Philips Digital Interface)
output to digital multimedia device through optical fiber or coaxial connector.

Pin Signal Name

1 SPDIFOUT
2 vcC
3 KEY
4 GND

CASE: Chassis Intrusion Detect Header

This detects if the chassis cover has been removed. This function needs a chassis
equipped with instrusion detection switch and needs to be enabled in BIOS.

Short | Chassis cover is removed

Open | Chassis cover is closed

ME_UNLOCK: ME Unlock Header

Short | Unlock

L Open | Lock J

COM: Onboard serial port header
Connect a serial port extension bracket to this header to add a serial port to your
system.

Pin Signal Name Function
1 DCDB Data Catrier Detect
2 SINB Serial Input
3 SOUTB UART B Serial Output
4 DTRB UART B Data Terminal Ready
5 GND Ground
6 DSRB Data Set Ready
7 RTSB RART B Request to Send
8 CTSB Clear to Send
9 RI Ring Indicator
10 Key No pin

Installing the Motherhoard
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Installing a SATA Hard Drive

This section describes how to install a SATA Hard Drive.

About SATA Connectors

Your motherboard features four SATA connectors supporting a total of four drives.
SATA refers to Serial ATA (Advanced Technology Attachment) is the standard inter-
face for the IDE hard drives which are currently used in most PCs. These connectors
are well designed and will only fit in one orientation. Locate the SATA connectors on
the motherboard and follow the illustration below to install the SATA hard drives.

Installing Serial ATA Hard Drives

To install the Serial ATA (SATA) hard drives, use the SATA cable that supports the
Serial ATA protocol. This SATA cable comes with a SATA power cable. You can
connect either end of the SATA cable to the SATA hard drive or the connector on the
motherboard.

——

SATA cable (optional) SATA power cable (optional)

Refer to the illustration below for proper installation:

1 Attach either cable end to the connector on the motherboard.

2 Attach the other cable end to the SATA hard drive.

3 Attach the SATA power cable to the SATA hard drive and connect the
other end to the power supply.

* For reference only

This motherboard supports the “Hot-Plug” function.

Installing the Motherhoard
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Connecting I/0 Devices
The backplane of the motherboard has the following I/O ports:

PS2
Mouse

USB 2.0
ports LAN port

% Line-in
(@ Line-out

0— Microphone

PS2 DVI port (HDMI optional) VGA port USB 2.0 ports (USB 3.0 optional)
keyboard
PS2 Mouse Use the upper PS/2 port to connect a PS/2 pointing device.

PS2 Keyboard
DVI Port (optional)

VGA Port

LAN Port

USB 2.0 Ports

Audio Ports

Use the lower PS/2 port to connect a PS/2 keyboard.
Connect the DVI port to the monitor.
Connect your monitor to the VGA port.

Connect an RJ-45 jack to the LAN port to connect your
computer to the Network.

Use the USB 2.0 ports to connect USB 2.0 devices. (Two of
USB 2.0 ports have optional USB 3.0 specification.)

Use the three audio ports to connect audio devices. The
first jack is for stereo line-in singal. The second jack is for
stereo line-out singal. The third jack is for microphone.

Installing the Motherhoard



Connecting Case Components

After you have installed the motherboard into a case, you can begin connecting the
motherboard components. Refer to the following:

Connect the CPU cooling fan cable to CPU_FAN.

Connect the standard power supply connector to ATX_POWER.
Connect the case switches and indicator LEDs to the F_PANEL.
Connect the system cooling fan connector to SYS_FAN.
Connect the auxiliary case power supply connector to ATX12V.
Connect the case speaker cable to SPK.

DO WN -~

ATX12V CPU_FAN

oA
@]

ATX_POWER

SYS_FAN PRI
F_PANEL

@ Connecting 24-pin power cable

The ATX 24-pin connector allows you to connect to ATX v2.x power supply.

With ATX v2.x power supply, users please
note that when installing 24-pin power
cable, the latches of power cable and the
ATX1 match perfectly.

rerrrrrry

24-pin power cable

Installing the Motherhoard
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The ATX12V4P power connector is used to provide power to the CPU.
\‘

-
4-pin power cable

{ g( Connecting 4-pin power cable

When installing 4-pin power cable, the
latches of power cable and the ATX12V4P
match perfectly.

CPU_FAN: CPU cooling FAN Power Connector

Pin Signal Name Function
1 GND System Ground
2 +12V Power +12V
3 Sense Sensor
4 PWM PWM

Users please note that the fan connector supports the CPU cooling fan of
1.14 ~ 2.24 (26.4W max) at +12V.

SYS_FAN: System Cooling FAN Power Connectors

Pin Signal Name Function

1 GND System Ground
+12V Power +12V

3 Sense Sensor

ATX_POWER: ATX 24-pin Power Connector

Pin Signal Name Pin Signal Name
1 +3.3V 13 +3.3V
2 +3.3V 14 -12V
3 Ground 15 Ground
4 +5V 16 PS_ON
5 Ground 17 Ground
6 +5V 18 Ground
7 Ground 19 Ground
8 PWRGD 20 -5V
9 +5VSB 21 +5V

10 +12V 22 +5V

1 +12V 23 +5V

12 | +33v 24 Ground

Installing the Motherhoard



ATX12V: ATX 12V Power Connector

Pin Signal Name

1 Ground
2 Ground
3 +12V
4 +12V

SPK: Internal speaker

Pin Signal Name

VCC

Key

GND

ENJEIVE YN

Signal

25
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Front Panel Header

The front panel header (F_PANEL) provides a standard set of switch and LED headers
commonly found on ATX or Micro ATX cases. Refer to the table below for informa-
tion:

2 10
o | O
| 3

F_PANEL

Pin  Signal Function Pin  Signal Function
HD_LED_P| Harddisk LED(+)| 2 | FP PWR/SLP| *MSG LED(+)
HD_LED_N| Harddisk LED(-)| 4 | FPPWR/SLP| *MSGLED(-)
RST_SW_N | Reset Switch(-) 6 | PWR_SW_P | Power Switch(+)
RST_SW_P | Reset Switch(+) 8 | PWR_SW_N| Power Switch(-)
RSVD Reserved 10 | Key No pin

O N | =

* MSG LED (dual color or single color)

Hard Drive Activity LED

Connecting pins 1 and 3 to a front panel mounted LED provides visual indication that
data is being read from or written to the hard drive. For the LED to function properly,
an IDE drive should be connected to the onboard IDE interface. The LED will also
show activity for devices connected to the SCSI (hard drive activity LED) connector.

Power/Sleep/Message waiting LED

Connecting pins 2 and 4 to a single or dual-color, front panel mounted LED provides
power on/off, sleep, and message waiting indication.

Reset Switch

Supporting the reset function requires connecting pin 5 and 7 to a momentary-
contact switch that is normally open. When the switch is closed, the board resets and
runs POST.

Power Switch

Supporting the power on/off function requires connecting pins 6 and 8 to a momen-
tary-contact switch that is normally open. The switch should maintain contact for at
least 50 ms to signal the power supply to switch on or off. The time requirement is
due to internal de-bounce circuitry. After receiving a power on/off signal, at least two
seconds elapses before the power supply recognizes another on/off signal.

This concludes Chapter 2. The next chapter covers the BIOS.

Installing the Motherhoard
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Chapter3
Using BIOS

About the Setup Utility

The computer uses the latest “American Megatrends Inc.” BIOS with support for
Windows Plug and Play. The CMOS chip on the motherboard contains the ROM
setup instructions for configuring the motherboard BIOS.

The BIOS (Basic Input and Output System) Setup Utility displays the system’s
configuration status and provides you with options to set system parameters. The
parameters are stored in battery-backed-up CMOS RAM that saves this information
when the power is turned off. When the system is turned back on, the system is
configured with the values you stored in CMOS.

The BIOS Setup Utility enables you to configure:

. Hard drives, diskette drives and peripherals
. Video display type and display options

. Password protection from unauthorized use
. Power Management features

The settings made in the Setup Utility affect how the computer performs. Before
using the Setup Utility, ensure that you understand the Setup Utility options.

This chapter provides explanations for Setup Utility options.

The Standard Configuration

A standard configuration has already been set in the Setup Utility. However, we
recommend that you read this chapter in case you need to make any changes in the
future.

This Setup Utility should be used:
. when changing the system configuration

. when a configuration error is detected and you are prompted to make
changes to the Setup Utility

. when trying to resolve IRQ conflicts
. when making changes to the Power Management configuration
. when changing the password or making other changes to the Security
Setup
Entering the Setup Utility

When you power on the system, BIOS enters the Power-On Self Test (POST)
routines. POST is a series of built-in diagnostics performed by the BIOS. After the
POST routines are completed, the following message appears:

Press DEL to enter SETUP

Using BIOS
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Press the delete key to access BIOS Setup Utility.

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

('ET] Advanced Chipset M.ILBIl Boot Security Exit

BIOS Information Choose the system default
language.
System Date [Mon 09/10/2012]
System Time [21:54:45] — +—:Select Screen
11 :Select ltem
Enter: Select

+/- : Change Opt.
F1:General Help
F2:Previous Values
F3:0ptimized Defaults
F4:Save & Exit
ESC:Exit

.1229. Copyright (C) 2012, American Megatrends, Inc.

Resetting the Default CMOS Values

When powering on for the first time, the POST screen may show a “CMOS
Settings Wrong” message. This standard message will appear following a clear
CMOS data at factory by the manufacturer. You simply need to Load Default
Settings to reset the default CMOS values.

Note: Changes to system hardware such as different CPU, memories, etc. may also
trigger this message.

American
Megatrends

H61H2-M3 Release 10/13/2010

Version 2.02.1205. Copyright (C) 2010 American Megatrends, Inc.
Press <F7> to enter BBS POPUP

Press <DEL> or <F2> to enter setup.

CMOS Setting Wrong

Using BIOS

When you start the Setup Utility, the main menu appears. The main menu of the
Setup Utility displays a list of the options that are available. A highlight indicates
which option is currently selected. Use the cursor arrow keys to move the highlight
to other options. When an option is highlighted, execute the option by pressing
<Enter>.

Some options lead to pop-up dialog boxes that prompt you to verify that you wish to
execute that option. Other options lead to dialog boxes that prompt you for infor-
mation.

Some options (marked with a triangle ) lead to submenus that enable you to change
the values for the option. Use the cursor arrow keys to scroll through the items in the
submenu.



In this manual, default values are enclosed in parenthesis. Submenu items are denoted
by a triangle ».

The default BIOS setting for this motherboard apply for most conditions
with optimum performance. We do not suggest users change the default
values in the BIOS setup and take no responsibility to any damage
caused by changing the BIOS settings.

BIOS Navigation Keys
The BIOS navigation keys are listed below:
| KEY FUNCTION
ESC Exits the current menu
fl—=— Scrolls through the items on a menu
+/- Modifies the selected field’s values
Enter Select
F1 General Help
F2 Previous Value
F3 Optimized Defaults
F4 Save & Exit

For the purpose of better product maintenance, the manufacture reserves
the right to change the BIOS items presented in this manual. The BIOS
setup screens shown in this chapter are for reference only and may differ
from the actual BIOS. Please visit the manufacture’s website for updated
manual.

Using BIOS
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Main Menu
This menu shows the information of BIOS and enables you to set the system
language, date and time.

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

'EIl)] Advanced Chipset M.I.BIIl Boot Security Exit

BIOS Information Choose the system default
language.
System Date [Mon 09/10/2012]
System Time [21:54:45] — «—:Select Screen
1l :Selectltem
Enter: Select

+/- : Change Opt.
F1:General Help
F2:Previous Values
F3:0Optimized Defaults
F4:Save & Exit
ESC:Exit

229. Copyright (C) 2012, American Megatrends, Inc.

System Language (English)
This item is used to set system language.
Date & Time

The Date and Time items show the current date and time on the computer. If you are
running a Windows OS, these items are automatically updated whenever you make
changes to the Windows Date and Time Properties utility.



Advanced Menu

The Advanced menu items allow you to change the settings for the CPU and other
system.

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main LGCIYELZE Chipset M.LBIII  Boot Securit

LAN Configuration Parameters

» PC Health Status

» Power Management Setup

» ACPI Settings

» CPU Configuration — «—:Select Screen

P SATA Configuration 11 :Select Item

» USB Configuration Enter: Select

» Super |0 Configuration +/- : Change Opt.

» Intel(R) Smart Connect Technology F1:General Help
F2:Previous Values
F3:0ptimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

» LAN Configuration

The item in the menu shows the LAN-related information that the BIOS
automatically detects.

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main LGIERIELE  Chipset M.L.BIII Boot Security Exit

Enable/Disable Onboard LAN

LAN Configuration Controller

Network Stack [Enabled] — «—:Select Screen
Ipv4 PXE Support [Enabled] 11 :Select ltem

Ipv6 PXE Support [Enabled] Enter : Select

+/- : Change Opt.
F1:General Help
F2:Previous Values
F3:Optimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

Onboard LAN Controller (Enabled)
Use this item to enable or disable the Onboard LAN.

Network stack (Enabled)
Use this item to enable or disable UEFI network stack.
Ipv4/6 PXE Support (Enabled)

Use these items to enable Ipv4/6 PXE Boot Support. If disabled Ipv4/6 PXE, boot
option will not be created.

Press <Esc> to return to the Advanced Menu page.

a1
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» PC Health Status

On motherboards support hardware monitoring, this item lets you monitor the
parameters for critical voltages, temperatures and fan speeds.

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main PGIYELULCE Chipset M.ILBIII Boot Security Exit

PC Health Status

CPU Fan Speed : 4299 RPM

CPU Vcore : 1596V — «—:Select Screen

VDIMM : 1,500V 1l :Select ltem

IMC Voltage : 1.056V Enter: Select
+/- : Change Opt.
F1:General Help

-=- PECI Mode -=- F2:Previous Values

Offset to TCC Activation Temp : -9 F3:Optimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

System Component Characteristics
These items display the monitoring of the overall inboard hardware health events,
such as IMC voltage, CPU fan speed...etc.

. CPU Fan Speed
. CPU Vcore

. VDIMM

. IMC Voltage

Press <Esc> to return to the Advanced Menu page.



» Power Management Setup

This page sets up some parameters for system power management operation.

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main LGCIELCE Chipset MBIl Boot Security Exit

About Resume by Ring
Power Management Setup
Resume By PCI/PCI-E/Lan PME [Disabled]
Resume By USB (S3) [Disabled] — —:Select Screen
Resume By PS2 KB (S3) [Disabled] 1l :Selectltem
Resume By PS2 MS (S3) [Disabled] Enter : Select
EUP Function [Enabled] +/- : Change Opt.

F1:General Help
F2:Previous Values
F3:0ptimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

Resume By RING (Disabled)

The system can be turned off with a software command. If you enable this item, the
system can automatically resume if there is an incoming call on the Modem. You
must use an ATX power supply in order to use this feature.

Resume By PCI/PCI-E/Lan PME (Disabled)

The system can be turned off with a software command. If you enable this item, the
system can automatically resume if there is an incoming call on the PCI Modem or
PCI LAN card. You must use an ATX power supply in order to use this feature. Use
this item to do wake-up action if inserting the PCI card.

Resume By USB (S3) (Disabled)

This item allows you to enable/disable the USB device wakeup function from S3
mode.

Resume By PS2 KB (S3) (Disabled)
This item enables or disables you to allow keyboard activity to awaken the system
from power saving mode.

Resume By PS2 MS (S3) (Disabled)
This item enables or disables you to allow mouse activity to awaken the system from
power saving mode.

EUP Support (Enabled)
This item allows user to enable or disable EUP support.

Press <Esc> to return to the Advanced Menu page.
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» ACPI Configuration

The item in the menu shows the highest ACPI sleep state when the system enters
suspend.

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main QLCVYEULLLE Chipset MBIl Boot Security Exit

ACPI Settings Selectthe highest ACPI sleep
state the system will enter
when the SUSPEND button
is pressed.

— —:Select Screen
1l :Selectitem

Enter: Select

+/- : Change Opt.
F1:General Help
F2:Previous Values
F3:0Optimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

ACPI Sleep State (S3(Suspend to RAM))
This item allows user to enter the APCI S3 (Suspend to RAM) Sleep State (default).

Press <Esc> to return to the Advanced Menu page.

» CPU Configuration

Scroll to this item and press <Enter> to view the following screen:

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main LCIELLGM Chipset MBIl Boot Security Exit

CPU Configuration Disabled for Windows XP
Intel(R) Core(TM) i5-2300 CPU 0 @ 2.80GHz
EMT64 [Supported]
Processor Speed 2800 MHz
Processor Stepping 206a2
Microcode Revision 2 — —:Select Screen
Processor Cores 4 1 s él oct ltem
Intel HT Technology [Not Supported] Ent.er - Select
+/- : Change Opt.
Execute Disable Bit [Enabled] Ii;{ge"‘?ra' "\'7'|p
Intel Virtualization Technology [Enabled] o O’et?"".“s h S “fes i
Power Technology [Energy Efficient] F 4:Sapv:ngzxit GENLS
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

Inter(R) Core(TM) i5-2300 CPU 0 @ 2.80 GHz

This is display-only field and diaplays the information of the CPU installed in your
computer.
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EMT64 (Supported)
This item shows the computer supports EMT64.

Processor Speed (2800MHz)
This item shows the current processor speed.

Processor Stepping (206a2)
This item shows the processor stepping version.

Microcode Revision (22)
This item shows the Microcode version.

Processor Cores (4)
This item shows the core number of the processor.

Intel HT Technology (Not Supported)
This item shows that your computer supports Intel HT technology or not.

Limit CPUID Maximum (Disabled)

Use this item to enable or disable the maximum CPUID value limit. When supports
Prescott and LGA775 CPUs, enables this to prevent the system from “rebooting”
when trying to install Windows NT 4.0.

Excute Disable Bit (Enabled)

This item allows the processor to classify areas in memory by where application code
can execute and where it cannot. When a malicious worm attempts to insert code in
the buffer, the processor disables code execution, preventing damage or worm propa-
gation. Replacing older computers with Execute Disable Bit enabled systems can halt
worm attacks, reducing the need for virus related repair.

Intel Virtualization Technology (Enabled)
When disabled, a VMM cannot utilize the additional hardware capabilities provided
by Vandor Pool Technology.

Power Technology (Energy Efficient)
Use this item to control the Energy mode of the processor.

Press <Esc> to return to the Advanced Menu page.
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> SATA Configuration

Use this item to show the mode of serial SATA configuration options.

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main -CIELLSC)  Chipset M.LBIII Boot Security Exit

SATA Configuration 8 gjgﬂ.&ﬁém aaClbeecs
Serial-ATA Controller 0 [Compatible]
Serial-ATA Controller 1 [Enhanced]
SATAPort1 Not Present — «—:Select Screen
1l :Selectlitem
SATAPort2 Not Present Enter : Select
+/- : Change Opt.
SATAPort3 Not Present F1:General Help
F2:Previ Vali
SATAPOrt4 Not Present F3:o§m::d .
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

SATA Mode (IDE Mode)
Use this item to select SATA mode.

Serial-ATA Controller 0/1 (Compatible/Enhanced)
Use this item to select the Serial-ATA cotroller options: Disabled, Compatible, En-
hanced.

SATA Port 1~4 (Not Present)

This motherboard supports four SATA channel and each channel allows one SATA
device to be installed. Use these items to configure each device on the SATA channel.

Press <Esc> to return to the Advanced Menu page.




» USB Configuration

Scroll to this item and press <Enter> to view the following screen:

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main P.CIELLCE Chipset M.ILBIII Boot Security Exit

USB Configuration Enabled/Disabled All USB
Devices

Legacy USB Support [Enabled] . —-Select Screen
Tl :Selectitem
Enter : Select

+/- : Change Opt.
F1:General Help
F2:Previous Values
F3:0ptimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

All USB Devices (Enabled)
Use this item to enable or disable all USB devices.

Legacy USB Support (Enabled)

Use this item to enable or disable support for legacy USB devices. Setting toAudio
allows the system to detect the presence of the USB device at startup. If detected, the
USB controller legacy mode is enabled. If no USB device is detected, the legacy USB
support is disabled.

Press <Esc> to return to the Advanced Menu page.

a7
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> Super 10 Configuration

Scroll to this item and press <Enter> to view the following screen:

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main LGIYELLLCE Chipset M.IL.BIIl Boot Security Exit

Super 10 Configuration Set Parameters of Serial Port
0 (COMA)

— «—:Select Screen
1 :Selectltem

Enter: Select

+/- : Change Opt.
F1:General Help
F2:Previous Values
F3:0ptimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

> Serial Port 0 Configuration
This item shows the information of the super 10 chip.

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main P.GIYEL(LE Chipset MBIl Boot Security Exit

Serial Port 0 Configuration Enable or Disable Serial Port
(COM)
Device Settings 10=3F8h; IRQ=4;
: — —:Select Screen
Change Settings [Auto]
g g [Aute] 1l :Selectitem
Enter: Select

+/- : Change Opt.
F1:General Help
F2:Previous Values
F3:Optimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

Serial Port (Enabled)
This item allows you to enable or disable serial port.
Device Settings (I0=3F 8h; IRQ=4)

This item shows the information of the device settings.

Change Settings (Auto)

Use this item to change device settings.



» Intel(R) Smart Connect Technology

Use this item to show the information of Intel(R) Smart Connect Technology.

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main LGCIELLSLE Chipset  M.LBIII  Boot Security  Exit

Enabled/Disabled ISCT Configura-

tion
ISCT Notification Control [Enabled]
ISCT WLAN Power Control [Enabled]
ISCT WWAN Power Control [Enabled] — «—:Select Screen
ISCT Sleep Duration Value Format [Actual Time] 11 Selectltem

Enter: Select

+/- : Change Opt.
F1:General Help
F2:Previous Values
F3:0ptimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

ISCT Configuration (Enabled)
Use this item to enable/disable ISCT Configuration.

ISCT Notification Control (Enabled)
Use this item to enable/disable ISCT Notification Control.

ISCT WLAN Power Control (Enabled)
Use this item to enable/disable ISCT WLAN Power Control.

ISCT WWAN Power Control (Enabled)
Use this item to enable/disable ISCT WWAN Power Control.

ISCT Sleep Duration Value Format (Actual Time)
Use this item to select actual time or duration in seconds. (ISCT 2.0)

Using BIOS
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Chipset Menu

The chipset menu items allow you to change the settings for the North Bridge
chipset, South Bridge chipset and other system.

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main Advanced goiliX3:1@ M.L.BIll Boot Security Exit

System Agent (SA) Parameters
» PCH Configuration
» ME Subsystem

— +—:Select Screen
11 :Select ltem

Enter: Select

+/- : Change Opt.
F1:General Help
F2:Previous Values
F3:0Optimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

» System Agent Configuration
Scroll to this item and press <Enter> and view the following screen:

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main Advanced [elii[.E1388 M.LBIll Boot Security Exit

Select which of IGFX/PEG/PCI

System Agent Configuration Graphics device should be Primary
Display Or select SG for Switchable
Gix.

1GD Memory [64M]

DVMT Mode Select [DVMT Mode] — «—:Select Screen

DVMT/FIXED Memory [256MB] 11 :Selectltem

IGD Multi-Monitor [Enabled] Enter: Select

+/- : Change Opt.
F1:General Help
F2:Previous Values
F3:Optimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

Initate Graphic Adapter (PCI Express)

This item allows you to select graphics controller to use as the primary boot device.
IGD Memory (64M)

This item shows the information of the IGD(Internal Graphics device) memory.
DVMT Mode Select (DVMT Mode)

This item allows you to select the DVMT operating mode.



DVMT/FIXED Memory (256MB)

When set to Fixed Mode, the graphics driver will reserve a fixed position of the
system memory as graphics memory, according to system and graphics requirements.

IGD Multi-Monitor (Enabled)

This item enables or disables IGD (Internal Graphics device) multi-monitor.

Press <Esc> to return to the chipset menu page.

Multi-Monitor technology

Multi-Monitor technology can help you to increase the area available for programs
running on a single computer system through using multiple display devices.

It is not only to increase larger screen viewing but aslo to improving personal
productivity.

|Inte| Integrated Graphics| | PCI-Express Graphics|

L]

/ ) Please note that Multi-Monitor technology supports up to four monitors:

one or two Intel integrated Graphics and one or two PCI-Express graphics
devices under Windows 7/8.

Step 1. Insert ECS drives DVD to run Auto setup or browse the DVD to install Intel
chipset drivers, VGA and sound drivers.(If you want know the detail information,

please refer to chapter 4.)

gl Mainboard Setup Utili

£V Utilities @ Information

ECS ELITEGROUP

Mainboard : HETH2-M3

BIOS Yersion : 10/22/10
Driver CD Yersion : D¥D 1.81
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Step 2. Install all the drivers of PCI-Express graphic cards. Click the Browse CD
item, then appears the following screen. Select the driver you want to install(e.g
NVIDIA GeForce 8400 GS(Microsoft Corporation-WDDM vl1.1)) and double click
it.

file Action View Help

eas | @B BE 8 R8RS
4 2 EC5-PC

&> % Computer

-y Disk drives

2 & Display adapters

i ../ NVIDIA GeForce 8400 GS (Microsoft Corporation - WDDM v1.1) |
<43 DVD/CD-ROM drives

& 45 Human Interface Devices

» i IDE ATA/ATAPI contrallers

» - Keyboards

& - Mice and other pointing devices

- Monitors

& i Network adapters

» BB Portable Devices

» [0 Processors

% Sound, video and game controllers

1> /M System devices
1§ Universal Serial Bus controllers

Step 3. Enable IGD Multi-Monitor from BIOS. In the following BIOS screen, please
set IGD Multi-Monitor to [Enabled].

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main Advanced [elii[.E1388 M.LBIll Boot Security Exit

Select which of IGFX/PEG/PCI

System Agent Configuration Graphics device should be Primary

§ X Display Or select SG for Switchable
Initate Graphic Adapter [PCI Express] Gix.

1GD Memory [64M]

DVMT Mode Select [DVMT Mode] — —:Select Screen
DVMT/FIXED Memory [256MB]

1l :Selectltem

Enter: Select

+/- : Change Opt.
F1:General Help
F2:Previous Values
F3:0ptimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.




Step 4. Change the appearance of your displays under Windows 7/8.

1. Enter the Control Panel menu, select the Display in the All Control Panel Items
and click the Screen Resolution, then appears the following screen.

Show the path of the setting location

Display devices

=
Control Panel »All Control Panel Items »Display »Screen Resolution Search Control Panel
Change the apprearance of your displays
Detect
Identify
Display: 1.DELLU2410 ~
Resolution: 1920x 1200 (recommended) +
Orientation: Landscay
Multiple displays: C Extend desktop to this display  +
This is currently your main display. Advance settings
Make text and other items larger or smaller
What display settings should | choose?
OK Cancel Apply
———The type of the display

Set the multiple displays

2.Select display devices, set the multiple displays option and to extend destop for
display “Multi-Monitor technology”.

> Control Panel »All Control Panel Items »Display »Screen Resolution Search Control Panel

Change the apprearance of your displays

[}I e
i

Display: 3.DELLU2410 ~
Resolution: 1920x 1200 (recommended) +
Orientation: Landscape o
Multiple displays:  Disconnect this display v
Extend desktop to this display
A\ Youmustselect Disconnect this display inges.
Make this my main aispiay Advance settings

Make text and other items larger or smaller
What display settings should | choose?

OK Cancel Apply
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» Control Panel »All Control Panel Items »Display »Screen Resolution Search Control Panel

Change the apprearance of your displays

DIDI -
i

Display: 4.AL1717 v

Resolution: 1920x 1200 (recommended) +
Orientation: Landscape v

Multiple displays:  Disconnect this display v

/\ Youmust select Apply before making additional changes.

Make this my main display Advance settings
Make text and other items larger or smaller
What display settings should | choose?

OK Cancel Apply

» Control Panel PAll Control Panel Items P Display » Screen Resolution Search Control Panel

Change the apprearance of your displays

EIEIEI
L

Display: 4.AL1717 v
Resolution: 1920 x 1200 (recommended)
Orientation: Landscape o

Multiple displays:  Extend desktop tothisdisplay v

/\ Youmust select Apply before making additional changes.

Make this my main display Advance settings
Make text and other items larger or smaller
What display settings should | choose?

OK Cancel Apply




» PCH Configuration
Scroll to this item and press <Enter> to view the following screen:

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main Advanced [efiiiEfI8 M.I.BIIl Boot Security Exit

PCH Configuration Select AC power state when power
is re-applied after a power failure
Audio Configuration
Azalia HD Audio [Enabled] — «—:Select Screen
Azalia Internal HDMI codec [Enabled] Tl :Selectltem
Enter : Select
Case Open Warning [Disabled] +/- : Change Opt.
Chassis Opened [No] F1:General Help
F2:Previous Values
F3:0ptimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

Restore AC Power Loss (Power Off)

This item enables your computer to automatically restart or return to its operating
status.

Audio Configuration

This item shows the information of the audio configuration.
Azalia HD Audio (Enabled)

This item enables or disables Azalia HD audio.

Azalia Internal HDMI codec (Enabled)

This item enables or disables Azaia Internal HDMI codec.

Case Open Warning (Disabled)

This item enables or disables the warning if the case is opened up, and the item below
indicates the current status of the case.

Chassis Opened (No)

This item indicates whether the case has been opened.

Press <Esc> to return to the chipset menu page.

Using BIOS
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» ME Subsystem
Scroll to this item and press <Enter> to view the following screen:

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main Advanced Qelil[:E118 M.I.BIll Boot Security Exit

Management Engine Technology Configuration

ME FW Version 8.1.0.1248

— «—:Select Screen
1l :Selectitem

Enter: Select

+/- : Change Opt.
F1:General Help
F2:Previous Values
F3:0ptimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

ME FW Version (8.1.0.1248)
This item shows the ME FW version.



M.LB III (MB Intelligent BIOS II1) Menu

This page enables you to set the clock speed and system bus for your system. The
clock speed and system bus are determined by the kind of processor you have
installed in your system.

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main Advanced Chipset W'HR:J[IM Boot Security Exit

M.LB IIl (MB Intelligent BIOS III) Integrated Clock Chip parameters

» Performance Tuning

B.O.M.P Technology [Enabled]

Auto Detect DIMM/PCI Clk [Enabled]

Spread Spectrum [Enabled]

Command Rate [Auto] — «—:Select Screen
CPU Voltage [Disabled] 11 :Select ltem

IMC Voltage [Disabled] e

DIMM Voltage [Disabled] St S

+/- : Change Opt.
F1:General Help

Intel(R) Core(TM) i5-2300 CPU @ 2.80GHz B s

Processor Speed 2800 MHz A

Total Memory 2048 MB (DDR3 1333) Ef;g:\t/'::;ii?efau'ts
CPU Current Voltage 1.596V EéC'Exit

IMC 1,056V :

VDIMM 1,500V

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

> Integrated Clock Chip Configuration
Scroll to this item to view the following screen:

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main Advanced Chipset Q'AN:J(IM Boot Security Exit

Integrated Clock Chip Configuration Integrated Clock Chip Enabled/
Disabled.

ICC OverClocking Lib Version 7.0.0.29

Number of ICC Profiles : N/A

CurrentICC Profile Index: N/A — —Select Screen
11 :Select ltem
Enter: Select

+/- : Change Opt.
F1:General Help
F2:Previous Values
F3:0ptimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

ICC Over-Clocking Lib Version (7.0.0.29)

This item shows the ICC over-clocking lib version.

Number of ICC Profiles (N/A)

This item shows number of ICC profiles.
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Current ICC Profiles Index (N/A)

This item shows current ICC profiles index.

ICC Enable (Disabled)

This item allows you to enable or disable current ICC.
Press <Esc> to return to the M.I.B III menu page.

» Performance Tunning
Scroll to this item to view the following screen:

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main Advanced Chipset JURE:1I[W Boot Security Exit

CPU Configuration
Performance Tuning
» Chipset Configuration — «—:Select Screen
1] :Selectitem
Enter: Select

+/- : Change Opt.
F1:General Help
F2:Previous Values
F3:Optimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

» CPU Configuration
Scroll to this item to view the following screen:

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main Advanced Chipset W'HE:X[IN Boot Security Exit

Integrated Clock Chip Parameters

CPU Ratio

[Normal]

Power Limit 1 Value (Watt) 9%

Power Limit 2 Switch [Enabled]

Power Limit 2 Value 18

Long duration maintained (Tau) 1

Enhanced Intel SpeedStep Technology ~ [Enabled] — ~—:Select Screen

Turbo Mode [Enabled] 1] :Selectltem

1 Core Ratio Limit 31 Enter: Select

2 Core Ratio Limit 30 +/- : Change Opt.

3 Core Ratio Limit 30 F1:General Help

4 Core Ratio Limit 29 F2:Previous Values
F3:0ptimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

CPU Ratio (28)

This item allows users to control non turbo CPU ratio.
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IA Core Current (Normal)

Use this item to control CPU Current Limit. This is for Turbo mode.
Power Limit 1 Value(Watt) (95)

Use this item to control the limit of the TDP. This is for Turbo mode.
Power Limit 2 Switch (Enabled)

Use this item to control the Power Limit 2. This is for Turbo mode.
Power Limit 2 Value (1)

Use this item to control Power Limit 2. PL2 provides an upper limit of the TDP
excursions. This is for Turbo mode.

Long duration maintainded(Tau) (1)

Use this item to control the time window over PL1 value should be maintained. This
is for Turbo mode.

Enhanced Intel SpeedStep Technology (Enabled)

This item allows users to enable or disable the EIST(Enhanced Intel SpeedStep
Technology).

Turbo Mode (Enabled)
This item allows you to control the Intel Turbo Boost Technology.
1/2/3/4-Core Ratio (31/30/30/29)

This item shows the Core Ratio limit value.

Press <Esc> to return to the Performance Tunning page.

Using BIOS
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» Chipset Configuration
Scroll to this item to view the following screen:

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main Advanced Chipset J'AN-X[IN Boot Security Exit

Memory Timing Configuration Cesllizmey Rengeeie,

Row Precharge Time (tRP) )
RAS#to CAS# Delay (tRCD) 9
RAS# Active Time (tRAS) 24
— «—:Select S
Intel Graphics Configuration 11 lseleecteltemcreen
GT OverColocking [Disabled] f}“egf:r'g‘: -

F1:General Help
F2:Previous Values
F3:0Optimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

Memory Timing Configuration
This item shows the information of Memory Timing Configuration.
CASt#tLatency(tcl) (9)

This item determines the operation of DDR SDRAM memory CAS (colulmn address
strobe). It is recommended that you leave this item at the default value. The 2T
setting requires faster memory that specifically supports this mode.

Row Precharge Time(tRP) (9)

This item specifies Row precharge to Active or Auto-Refresh of the same bank.
RAS# to CAS# Delay(tRD) (9)

This item specifies the RAS# to CAS# delay to Rd/Wr command to the same bank.
RAS# Active Time(tRAS) (24)

This item specifies the RAS# active time.

Intel Graphics Configuration

This item shows the information of Intel Graphics Configuration.

GT OverClocking [Disabled]

This item allows you to control the internal GFX Turbo mode.

Press <Esc> to return to the Performance Tunning page.

Press <Esc> to return to the M.I.B III menu page.



B.O.M.P Technology (Enabled)
This item allows users to enable or disable B.O.M.P technology. This function can
run safe setting to setup menu when system boot fail 3 times.

Auto Detect DIMM/PCI Clk (Enabled)
When this item is enabled, BIOS will disable the clock signal of free DIMM/PCI slots.

Spread Spectrum (Enabled)
If you enable spread spectrum, it can significantly reduce the EMI (Electro-Magnetic
Interference) generated by the system.

Command Rate (Auto)

This item allows users to set command rate.

CPU Voltage (Disabled)

This item allows users to adjust the CPU voltage.
IMC Voltage (Disabled)

This item allows users to adjust the IMC voltage.
DIMM Voltage (Disabled)

This item allows users to adjust the DIMM voltage.

Intel(R) Core(TM) i5-2300 CPU @ 2.80 GHz
This is display-only field and displays the information of the CPU installed in your
computer.

Processor Speed (2800MHz)

This item shows the CPU speed.

Total Memory (2048MB(DDR3 1333))
This item shows the total momery of DDR3.
CPU Current Voltage (1.596V)

This item diplays the CPU current voltage.

IMC (1.056V)
This item displays the current IMC voltage.

VDIMM (1.500V)
This item displays the current VDIMM voltage.

Using BIOS
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Boot Menu

This page enables you to set the keyboard NumLock state.

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main Advanced Chipset M.L.BIII

: Windows 7 or other OS:
Boot Configuration Bootpolicy for Legacy OS
Launch PXE OpROM [Disabled] Windows 8: Boot Policy for
Launch Storage OpROM [Enabled] UEFI| OS without
Compatibility Support
Bootup NumLock State [On] Module (CSM)
Quiet Boot [Enabled] .
Boot mode select [LEGACY] Manual: User customized
CSM parameters & boot
Set Boot Priority policy
Boot Option #1 [Hard Disk]
Boot Option #2 [CD/DVD]
Boot Option #3 [USB/ Floppy]
Boot Option #4 [USB CD/DVD]
Boot Option #5 [USB Hard Disk]
Boot Option #6 [USB Flash]
Boot Option #7 [Network]
Hard Disk Drive Priorities [Press Enter] — —:Select Screen
CD/DVD ROM Drive Priorities [Press Enter] 1] :Selectitem
USB/ Floppy Drive Priorities [Press Enter] Enter : Select
USB CD/DVD ROM Drive Priorities [Press Enter] +/- : Change Opt.
USB HardDisk Drive Priorities [Press Enter] F1:General Help
USB Flash Drive Priorities [Press Enter] F2:Previous Values
Network Device Priorities [Press Enter] F3:Optimized Defaults
F4:Save & Exit
»CSM parameters [Press Enter] ESC:Exit

1229. Copyright (C) 2012, American Megatrends, Inc.

Boot Configuration

This item shows the information of the Boot Configuration.
Operation System Select (Windows7 or other OS)
This item is used to select the operation system.

Launch PXE OpROM (Disabled)

The item enables or disables launch PXE Option ROM.
Launch Storage OpROM (Enabled)

The item enables or disables launch Storage Option ROM.
Bootup NumLock State (On)

This item enables you to select NumLock state.

Quiet Boot (Enabled)

This item enables or disables quiet boot.

Boot mode select (LEGACY)

Use this item to select boot mode.

Set Boot Priority

This item enables you to set boot priority for all boot devices.
Boot Option #1/2/3/4/5/6/7

These items show the boot priorities.

Using BIOS



Hard Disk / CD/DVD ROM / USB Floppy / USB CD/DVD ROM / USB HardDisk /
USB Flash / Network Boot Drive Priorities

These items enable you to specify the sequence of loading the operating system.
Press <Enter> to see the submenu.

CSM parameters
OpROM execution, boot options filter,etc.

» CSM parameters
Scroll to this item and press <Enter> to view the following screen.

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main Advanced Chipset M.LBII Security  Exit

This option controls if CSM
will be launched

Boot option filter [UEFI and Legacy]
Launch PXE OpROM policy [Do not launch]
Launch Storage OpROM policy [Legacy only]
Launch Video OpROM policy [Legacy only] .
Other PCI device ROM priority [Legacy OpROM] T_l. ‘;-Isec'tel‘;‘t Screen
:Select Item
Enter : Select

+/- : Change Opt.
F1:General Help
F2:Previous Values
F3:0ptimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

Launch CSM

This option controls if CSM will be launched.

Boot option filter

This option controls what devices system can boot to.

Launch PXE OpROM policy

This controls the execution of UEFI and Legacy PXE OpROM.
Launch Storage OpROM policy

This controls the execution of UEFI and Legacy Storage OpROM.
Launch Video OpROM policy

This controls the execution of UEFI and Legacy Video OpROM.

Other PCI device ROM priority
For PCI devices other than Network, Mass storage or Video defines which OpROM to
launch.

Press <Esc> to return to the Boot Menu page.
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Security Menu

This page enables you to set setup administrator password and user password.

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main Advanced Chipset M.LBIll Boot [ELEJUOVA Exit

- Secure Boot mode selector. ‘Stan-
Administrator Password Status Not Install dard’ -fixed Secure boot policy,
User Password Status Not Install ‘Custom’ -changeable Image Ex-
Administrator Password ecution policy and Secure Boot Key

data bases
System Mode state Setup .
Secure Boot state Disabled avaseeel
1l :Selectitem
Enter: Select
Secure Boot [Enabled] +/- : Change Opt.
» Image Execution Policy T:L:gengral Hvelf
> e Ereeeat :Previous Values
Y d F3:0Optimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

Administrator Password Status (Not Install)

This item shows administrator password installed or not.
User Password Status (Not Install)

This item shows user password installed or not.

System Mode state (Setup)

This item shows system mode setup or not.

Secure Boot state (Disabled)

This item allows you to enable or disable the secure boot state.
Secure Boot (Enabled)

This item is used to control the secure boot flow, it is possible only if system runs in
User Mode.

Secure Boot Mode (Custom)

This item is used to select secure boot mode, when you select standard mode, secure
boot policy is fixed; when you select custom mode, the image execution policy and
secure boot key databases are changeable.
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» Image Execution Policy
Scroll to this item to view the following screen:

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main Advanced Chipset M.L.BIIl Boot ELLVG"A Exit

Image Execution Policy per device
path on Security Violation. Note:

Option ROM [Deny Execute] onl .

) ly users logged with
Removable Media [Deny Execute] o e
Fixed Media [Deny Execute] SR FESSa

exercise Query User policy setting

— «—:Select Screen
1l :Selectitem

Enter: Select

+/- : Change Opt.
F1:General Help
F2:Previous Values
F3:Optimized Defaults
F4:Save & Exit
ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

Internal FV/Option ROM/Removable Media/Fixed Media (Always Execute/
Deny Execute)

These items allow you to select image execution policy per device path on security
violation. Only users logged with administrative password can exercise query user
policy setting.

Press <Esc> to return to the Security Menu page.
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» Key Management
Scroll to this item to view the following screen:

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main Advanced Chipset M.LBIIl Boot KEL:141414%

Force OEM default Secure
Manage All Factory Keys (PK, KEK, DB, DBX) Boot Keys if System s in
Install default Secure Boot keys Setup Mode.
Platform Key (PK) NOT INSTALLED
P Set PK from File
» GetPK to File
» Delete the PK
Key Exchange Key Database (KEK) NOT INSTALLED
» Set KEK from File
» Get KEK to File
» Delete the KEK
» Append an entry to KEK
Authorized Signature Database (DB) NOT INSTALLED
» Set DB from File — —:Select Screen
» Get DB to File 1l :Selectltem
» Delete the DB Enter: Select
» Append an entry to DB +/- : Change Opt.
Forbidden Signature Database (DBX) NOT INSTALLED F1:General Help
» Set DBX from File F2:Previous Values
» GetDBXto File F3:Optimized Defaults
» Delete the DBX F4:Save & Exit
» Append an entry to DBX ESC:Exit

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

Default Key Provisioning (Disabled)
This item enables or disables you to force OEM default secure boot keys if system is
in setup mode.

Platform Key (PK)

This item shows the information of the platform key.

Set PK/KEK/DB/DBX from File

This item launches the file browser to set Efi Variable from the file. The file data
must be formatted as Efi Variable with TimeBased Authenticated Header.

Get PK/IKEK/DB/DBX to File

This item is used to store secure variable to a file with a matching name in selected
file system’s root.

Delete the PK/IKEK/DB/DBX

This item is used to delete the variable.

Key Exchange Key Database (KEK)

This item shows the information of the key exchange key database.
Authorized Signature Database (DB)

This item shows the information of the authorized signature database.
Forbidden Signature Database (DBX)

This item shows the information of the forbidden signature database.
Append an entry to KEK/DB/DBX

This item launches the file browser to Append new signature database from the file.
The file data must be formatted as Efi Variable with TimeBased Authenticated Header.

Using BIOS



Exit Menu

This page enables you to exit system setup after saving or without saving the
changes.

Aptio Setup Utility - Copyright (C) 2012 American Megatrends, Inc.

Main Advanced Chipset M.ILBIll Boot Security 33

Exit system setup after saving
Discard Changes and Exit the changes.

Save Changes and Reset
Discard Changes and Reset

— «—:Select Screen

Save Options 1l :Selectltem
Save Changes Enter: Select
Discard Changes +/- : Change Opt.
F1:General Help

Restore Defaults F2:Previous Values
Save as User Defaults F3:Optimized Defaults
Restore User Defaults F4:Save & Exit

. ESC:Exit
Boot Override

Version 2.15.1229. Copyright (C) 2012, American Megatrends, Inc.

Save Changes and Exit
This item enables you to save the changes that you have made and exit.

Discard Changes and Exit
This item enables you to discard any changes that you have made and exit.

Save Changes and Reset
This item enables you to save the changes that you have made and reset.

Discard Changes and Reset
This item enables you to discard any changes that you have made and reset.

Save Options
This item enables you to save the options that you have made.

Save Changes
This item enables you to save the changes that you have made.

Discard Changes
This item enables you to discard any changes that you have made.

Restore Defaults
This item enables you to restore the system defaults.

Save as User Defaults
This item enables you to save the changes that you have made as user defaults.

Restore User Defaults
This item enables you to restore user defaults.

Boot Override
Use this item to select the boot device.
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Updating the BIOS

You can download and install updated BIOS for this motherboard from the
manufacturer’s Web site. New BIOS provides support for new peripherals, improve-
ments in performance, or fixes for known bugs. Install new BIOS as follows:

1

If your motherboard has a BIOS protection jumper, change the setting to
allow BIOS flashing.

If your motherboard has an item called Firmware Write Protect in Ad-
vanced BIOS features, disable it. (Firmware Write Protect prevents
BIOS from being overwritten.)

Prepare a bootable device or create a bootable system disk. (Refer to
Windows online help for information on creating a bootable system
disk.)

Download the Flash Utility and new BIOS file from the manufacturer’s
Web site. Copy these files to the bootable device.

Turn off your computer and insert the bootable device in your com-
puter. (You might need to run the Setup Utility and change the the boot
priority items on the Advanced BIOS Features Setup page, to force
your computer to boot from the bootable device first.)

At the C:\ or A:\ prompt, type the Flash Utility program name and the file
name of the new BIOS and then press <Enter>. Example: AFUDOS.EXE
040706.ROM

When the installation is complete, remove the bootable device from the
computer and restart your computer. If your motherboard has a Flash
BIOS jumper, reset the jumper to protect the newly installed BIOS from
being overwritten. The computer will restart automatically.

This concludes Chapter 3. Refer to the next chapter for information on the software
supplied with the motherboard.

Using BIOS
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Chapter 4
Using the Motherhoard Software

Auto-installing under Windows XP/7/8

The auto-install DVD-ROM makes it easy for you to install the drivers and software.
The support software DVD-ROM disc loads automatically under Windows XP/7/8.
When you insert the DVD-ROM disc in the DVD-ROM drive, the auto-run feature
will automatically bring up the installation screen. The screen has four buttons on it:
Setup, Utilities, Browse CD and Exit.

g Mainboard Setup Utility

iver | A Uits » Information:

Displays the path for all
B'S ELITEGROUP software and drivers

available on the disk.

Mainboard : HETHZ-M3 Click “Exit” button to

BIOS Version : 10/22/10
Driver CD Version : DVD 1.8; close the Auto-Setup

window.

Browse CD:

3 Open Windows Explorer
\ »| and show the contents
| of the support disk.

y

Click the “Setup” Click the “ Utilities”
button to select and| |button to select and
run the software| [install ECS Intelligent
installation program. Utility.

Running Setup

Follow these instructions to install device drivers and software for the motherboard:

1. Click Setup. The installation program begins:

H61H2-M3
AutoSetup Program:

Auto Setup Paciage so

Mainbosrd 1D

The following screens are examples only. The screens and driver lists will
be different according to the motherboard you are installing.

The motherboard identification is located in the upper left-hand corner.

Using the Motherhoard Software
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2. Click Next. The following screen appears:

Auto Setup Package software Version 2.00.0009

Select Features i
Choose the feaures Setup wil sl ‘ :

Select the features you want to instal, clear the features you do not want to instal

Dessiption

IR Chipset Software Installation Uty Version £:0.0.1011
Rielease Date : 2004/05/28

Space Requiedon C: 40785 K
Space Avalableon 29083888 K.

<Back Caneel

3. Check the box next to the items you want to install. The default options are recommended.

4.  Click Next to run the Installation Wizard. An item installation screen appears:

|

s
Welcome to the InstallShield[R) Wizard for
i : Intel(R) Chipset Software Installation Utility

Welcome 1o the Intel(R) Chipset Softnars Instaltion
Ulty. This utlty will enable Plag & Play INF support for
i) chipset components

o =

5.  Follow the instructions on the screen to install the items.

Drivers and software are automatically installed in sequence. Follow the
onscreen instructions, confirm commands and allow the computer to
restart a few times to complete the installation.

Windows 8 will show the following screen after system restart, you
must select “Desktop” in the bottom left to install the next driver.

ecs test o

Calendar

XooxUVEGomes  Camera

Using the Motherhoard Software



Windows 7/8 will appear below UAC (User Account Control) message after
the system restart. You must select “Yes” to install the next driver. Continue
this process to complete the drivers installation.

%) User Account Control @

Do you want to allow the following program from an
unknown publisher to make changes to this computer?

Program name:  ChPrio.exe
Publisher: Unknown
File origin: CD/DVD drive

iif:? Show details Yes

Change when these notifications appear

Manual Installation

If the auto-install DVD-ROM does not work on your system, you can still install
drivers through the file manager for your OS (for example, Windows Explorer).
Look for the chipset and motherboard model, and then browse to the directory and
path to begin installing the drivers. Most drivers have a setup program (SETUP.EXE)
that automatically detects your operating system before installation. Other drivers
have the setup program located in the operating system subfolder.

If the driver you want to install does not have a setup program, browse to the
operating system subfolder and locate the readme text file (README.TXT or
README.DOC) for information on installing the driver or software for your oper-
ating system.

ECS Utility Software (Intelligent EZ Utility)

ECS Intelligent EZ Utility provides friendly interfaces under Windows O.S, which
makes your computing more easily and conveniently.

These software(s) are subject to change at anytime without prior notice. Please
refer to the support disk for available software.

Using the Motherhoard Software
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eSF

eSF(Smart Fan) utility provides easy and safe way to adjust fan speed in accordance
with your PC’s system loading and temperature.
It has five modes to adjust fan speed in a safe range without entering the BIOS to
optimize your system cooling environment.

(Ger R =

B 3£ oma
H pe -
= o -_—

——
Temgertre

[

@ Microsoft .NET Framework 3.5 is required.

eDLU

ECS eDLU utility makes updating drivers fast and easy. eDLU saves time and hassle
by listing all the latest drivers online. Just select the one you prefer and start to
download and install the drivers.

]

ECS ELITEGROUP.
y .
Driver Live Update

System Information:
Processor: XXX-X000( CPU @ XXX GHz.

Motherboard: 000X ¢
BIOS:  American Megatrends Inc. version XY00(XX)XX

Operating System: _ Micorsoft Windows X000 X¥bit

eBLU

ECS eBLU utility makes BIOS update faster and easier. eBLU will list the latest BIOS
with a default check-mark. Click”install” button to install.

L o i = BLU , 2l

| system tnformation
Procesor:  X00000KCPU @ XK GHE
Nathersoart: 5000000

BI0S:  American Megatrends In. version

Operating System:  Microft Windows X000

|l Recommended Updates

Rem

Microsoft .NET Framework 3.5 is required.
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Chapter 5
Trouble Shooting

Start up problems during assembly

After assembling the PC for the first time you may experience some start up
problems. Before calling for technical support or returning for warranty, this chapter
may help to address some of the common questions using some basic troubleshooting
tips.

a) System does not power up and the fans are not running.

1.Disassemble the PC to remove the VGA adaptor card, DDR memory, LAN, USB
and other peripherals including keyboard and mouse. Leave only the motherboard,
CPU with CPU cooler and power supply connected. Turn on again to see if the
CPU and power supply fans are running.

2. Make sure to remove any unused screws or other metal objects such as screwdrivers
from the inside PC case. This is to prevent damage from short circuit.

3. Check the CPU FAN connector is connected to the motherboard.

4. For Intel platforms check the pins on the CPU socket for damage or bent. A bent
pin may cause failure to boot and sometimes permanent damage from short circuit.

5. Check the 12V power connector is connected to the motherboard.

6. Check that the 12V power & ATX connectors are fully inserted into the
motherboard connectors. Make sure the latches of the cable and connector are
locked into place.

b) Power is on, fans are running but there is no display

1. Make sure the monitor is turned on and the monitor cable is properly connected
to the PC.

2. Check the VGA adapter card (if applicable) is inserted properly.

3. Listen for beep sounds. If you are using internal PC speaker make sure it is
connected.

a. continuous 3 short beeps: memory not detected

b. 1 long beep and 8 short beeps: VGA not detected

¢) The PC suddenly shuts down while booting up.

1. The CPU may experience overheating so it will shutdown to protect itself.
Ensure the CPU fan is working properly.
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2. From the BIOS setting, try to disable the Smartfan function to let the fan run at
default speed. Doing a Load Optimised Default will also disable the Smartfan.

Start up problems after prolong use

After a prolong period of use your PC may experience start up problems again.
This may be caused by breakdown of devices connected to the motherboard such as
HDD, CPU fan, etc. The following tips may help to revive the PC or identify the
cause of failure.

1. Clear the CMOS values using the CLR_CMOS jumper. Refer to CLR_CMOS

jumper in Chapter 2 for Checking Jumper Settings in this user manual. When
completed, follow up with a Load Optimised Default in the BIOS setup.

2. Check the CPU cooler fan for dust. Long term accumulation of dust will reduce
its effectiveness to cool the processor. Clean the cooler or replace a new one if
necessary.

3. Check that the 12V power & ATX connectors are fully inserted into the
motherboard connectors. Make sure the latches of the cable and connector are
locked into place.

4. Remove the hard drive, optical drive or DDR memory to determine which of
these components may be at fault.

Maintenance and care tips

Your computer, like any electrical appliance, requires proper care and maintenance.
Here are some basic PC care tips to help prolong the life of the motherboard and
keep it running as best as it can.

1. Keep your computer in a well ventilated area. Leave some space between the PC
and the wall for sufficient airflow.

2. Keep your computer in a cool dry place. Avoid dusty areas, direct sunlight and areas
of high moisture content.

3. Routinely clean the CPU cooler fan to remove dust and hair.

4. In places of hot and humid weather you should turn on your computer once every
other week to circulate the air and prevent damage from humility.

5. Add more memory to your computer if possible. This not only speeds up the system
but also reduces the loading of your hard drive to prolong its life span.

6. If possible, ensure the power cord has an earth ground pin directly from the wall
outlet. This will reduce voltage fluctuation that may damage sensitive devices.
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Memo

Trouble Shooting



